
Working Together 1:
Word 2007 and

Your Web Browser

WDWT1.1

The Adventure Travel Tours Web site is used to pro-
mote its products and broaden its audience of cus-
tomers. In addition to the obvious marketing and
sales potential, it provides an avenue for interaction
between the company and the customer to improve
customer service. The company also uses the Web
site to provide articles of interest to customers. The
articles, which include topics such as travel back-
ground information and descriptions, changes on a
monthly basis as an added incentive for readers to re-
turn to the site.

You want to use the flyer you developed to pro-
mote the new tours and presentations on the Web

site. To do this, you will use Word 2007’s Web-editing
features that help you create a Web page quickly and
easily. While using the Web-editing features, you will
be working with Word and with a Web browser appli-
cation. This capability of all 2007 Microsoft Office ap-
plications to work together and with other applications
makes it easy to share and exchange information be-
tween applications. Your completed Web pages are
shown here.

Note: The Working Together tutorial is designed to
show how two applications work together and to
present a basic introduction to creating Web pages.

Case Study
Adventure Travel Tours
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WDWT1.2 Working Together 1: Word 2007 and Your Web Browser www.mhhe.com/oleary
Word 2007

•Saving a Word Document as a Web Page
You want to create a Web page to be used on the company’s Web site. A
Web page is a document that can be used on the World Wide Web
(WWW). The Web page you will create will provide information about the
tour presentations. Word offers two ways to create or author Web pages.
One way is to start with a blank Web page and enter text and graphics
much as you would a normal document. Another is to quickly convert an
existing Word document to a Web page.

Because the tour flyer has already been created as a Word document
and contains much of the information you want to use on the Web page,
you will convert it to a Web page document. You made a couple of changes
to the flyer, giving it a title that is more appropriate for the Web page and
removing the banner. You will use the modified version of the flyer as the
basis for the Web page.

1 • Start Word 2007.

• Open the file
wdwt_Presentations
from the appropriate
location.

Your screen should be
similar to Figure 1

Figure 1

Word converts a document to a Web page by adding HTML coding to the
document. HTML (HyperText Markup Language) is a programming
language used to create Web pages. HTML commands control the display
of information on a page, such as font colors and size, and the way an
item will be processed. HTML also allows users to click on hyperlinks and

Revised flyer
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Saving a Word Document as a Web Page WDWT1.3

Word 2007

jump to other locations on the same page, other pages in the same site, or
other sites and locations on the WWW. HTML commands are interpreted
by the browser software you are using. A browser is a program that
connects you to remote computers and displays the Web pages you
request.

When a file is converted to a Web page, the HTML coding is added and
it is saved to a new file with an .html file extension. You want to save the
Web page using the file name New Tour Presentations in a new folder.

2 • Click Office Button
and choose Save as.

• If necessary, change
the location to save to
the appropriate save
location.

• Create a new folder
named ATT Web Page.

• Change the file name
to New Tour
Presentations.

• From the Save as Type
drop-down list, choose
Web Page.

Your screen should be
similar to Figure 2

Figure 2

You also need to provide a title for the page. This is the text that will
appear in the title bar of the Web browser when the page is displayed. You
want the title to be the same as the file name.

Folder to save
web page in

Web page file type
Adds title
to web page
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WDWT1.4 Working Together 1: Word 2007 and Your Web Browser www.mhhe.com/oleary
Word 2007

3 • Click .

• Change the title to
New Tour
Presentations.

• Click .

• Click .

Your screen should be
similar to Figure 3

Figure 3

Some formatting features,
such as emboss and shadow
effects, are not supported by
HTML or other Web browsers
and are not available when
authoring Web pages.

Additional Information The flyer has been converted to an HTML document and is displayed in
Web Layout view. This view displays the document as it will appear if
viewed using a Web browser. This document looks very much like a
normal Word document. In fact, the only visible difference is the margin
settings. A Web page does not include margins. Instead, the text wraps to
fit the window space. However, the formatting and features that are
supported by HTML, in this case the paragraph and character formatting
such as the font style, type size, and color attributes, have been converted
to HTML format.

No margins

Web Layout view

Text wraps to
fit window
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Making Text Changes WDWT1.5

Word 2007

•Making Text Changes
Next, you want to change the layout of the Web page so that more
information is displayed in the window when the page is viewed in the
browser. To do this, you will delete any unnecessary text and change the
paragraph alignment to left-aligned.

1 • Delete the last two
paragraphs.

• Left-align all the text
below the picture.

• Add bullets preceding
the list of four tours.

• Increase the font size
of the title to 36
points.

• Clear the highlight.

Your screen should be
similar to Figure 4

Figure 4Last two paragraphs
deleted

Bullets added

Text left aligned

Now, all the information is visible within the window.

Font size increased
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Word 2007

•Changing the Picture Layout
Next, you want to move the picture to the left edge of the window and
wrap the text to the right around it. Unlike a normal Word document, a
Web page document does not have pictures and other graphic elements
embedded in it. In an HTML file, each graphic object is stored as a
separate file that is accessed and loaded by the browser when the page is
loaded. In an HTML file, each graphic object is stored as a separate file
that is accessed and loaded by the browser when the page is loaded. Word
creates a link to the object’s file in the HTML file. The link is a tag that
includes the location and file name of the graphic file.

Additionally, graphics are inserted into a Web page document as inline
objects. You can change the wrapping style and move, size, and format
graphic objects in a Web page just like embedded objects in a Word
document.

1 • Click on the picture to
select it.

• Drag the picture to the
“T” in “This” at the
beginning of the first
paragraph.

• From the Picture Tools
Format tab, click

and
select Square.

Your screen should be
similar to Figure 5

When graphic files are added
to a Web page, they are
copied to the same folder
location as the Web page.
The graphic files must always
reside in the same location as
the HTML document file in
which they are used.

Additional Information

Figure 5

Next, you will make a few other adjustments to improve the appearance.

Graphic moved and wrapping
style changed to square
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Applying Page Color WDWT1.7

Word 2007

•Applying Page Color
Because color and design are important elements of Web pages, you can
add a background color to the Web page. You think a light blue may look
good.

1 • Deselect the graphic.

• Open the Page Layout
tab.

• Click in
the Page Background
group.

• Point to several
different shades of
blue to see how they
look in Live Preview.

Your screen should be
similar to Figure 6

Figure 6

Page color Live Preview

The gallery of colors
associated with the default
Office theme is displayed.

Additional Information

You do not really like how any of these colors look and decide to try a
fill effect instead. Fill effects include gradient color, texture, patterns, or
pictures. These effects should be used in moderation—you want them to
enhance, not detract from, the content. You will try a blue gradient
effect first.
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Word 2007

2 • Choose Fill Effects.

• Choose One color.

• From the Color1 drop-
down list, select Blue,
Accent 1, Lighter 40%

• Drag the shade slider
closer to the Light side
(see Figure 7).

• If necessary, select
Horizontal in the
Shading styles
options.

• Select the top to
bottom variant (upper-
right square).

Your screen should be
similar to Figure 7

Figure 7

Shade slider

Top to bottom
variant

Shading styles Fill effect
previewed

The Sample area shows how your color selections will appear. Now you
are ready to apply these settings to the page.

Figure 8

3 • Click .

Your screen should be
similar to Figure 8

Although adding gradient color shading looks nice, you still are not
satisfied. You will try a texture instead.

Selected color

Gradient color applied
to page background
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Applying Page Color WDWT1.9

Word 2007

4 • Click .

• Choose Fill Effects.

• Open the Texture tab.

• Select the Stationery
texture (fourth row,
fourth column).

• Click .

Your screen should be
similar to Figure 9

Figure 9Texture fill effect applied to
page background

You like the more natural effect of this background.

When you click on a texture,
the texture name appears
below the list box.

Having Trouble?
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Word 2007

•Changing Bullet Styles
The last enhancement you want to make is to change the bullet style.

1 • Select the four
bulleted items.

• Open the Home tab.

• Open the Bullets
drop-down gallery.

• Choose from the
Bullet Library.

• Clear the selection.

• Save the changes you
have made to the Web
page.

Your screen should be
similar to Figure 10

Many more graphic bullets
are available in the Web
Elements folder of the Clip
Organizer.

Additional Information

Figure 10

Bullet style
changed
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Creating a Hyperlink WDWT1.11

Word 2007

•Creating a Hyperlink
Next, you want to create another Web page that will contain a list of
presentation locations. You will then add a hyperlink to this information
from the New Tour Presentations page. As you have learned, a hyperlink
provides a quick way to jump to other documents, objects, or Web pages.
Hyperlinks are the real power of the WWW. You can jump to sites on your
own system and network as well as to sites on the Internet and WWW.

The list of tour locations has already been entered as a Word document
and saved as a file.

1 • Open the file
wdwt_Locations.

• Save the document as
a Web page to the ATT
Web Page folder with
the file name Tour
Locations and a page
title of Tour
Presentation
Locations.

• Apply the same bullet
style to this page.

• Apply the Stationery
texture background
page color.

• Save the page again.

Your screen should be
similar to Figure 11

Figure 11

Now you are ready to create the hyperlink from the New Tour Presentations
page to the Tour Locations page.

Bullets style changed Stationery texture applied
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2 • Switch to the New
Tour Presentations
window.

• Add the following text
to the end of the last
paragraph: Find out
about presentation
locations, dates, and
times.

• Select the text
“locations, dates, and
times.”

• Open the Insert tab.

• Select 
from the Links group.

Your screen should be
similar to Figure 12

The keyboard shortcut
is c + K.

Another Method

Figure 12

From the Insert Hyperlink dialog box, you need to specify the name of the
document you want the link to connect to.

3 • Select Tour
Locations.htm from
the file list.

• Click .

• Save the document.

Your screen should be
similar to Figure 13

Figure 13

Create hyperlink

Text to be used as
hyperlink

Select document
to link to

Hyperlink formatted
in theme colors
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Creating a Hyperlink WDWT1.13

Word 2007

The selected text appears as a hyperlink in the design colors specified by
the theme.

Next, you will use the hyperlink to display the Presentation Locations
document.

4 • Hold down c and
click the hyperlink.

Your screen should be
similar to Figure 14

Figure 14Linked page displayed

Because the Locations document is already open in a window, clicking the
hyperlink simply switches to the open Word window and displays the page.
You plan to add hyperlinks from each location to information about
specific location dates and times at a later time.
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•Previewing the Page
To see how your Web page will actually look when displayed by your
browser, you can preview it.

Note: The following figures will display Internet Explorer 7, If you are using a different browser
or a different version of Internet Explorer, your screens will look different. Additionally, you will
need to substitute the equivalent procedures for your browser in the following steps.

1 • Open your Web
browser.

• If necessary, maximize
the browser window.

• Open the Location
drop-down menu and
change to the location
containing the ATT
Web Page folder.

• Choose New Tour
Presentations.htm
from the ATT Web
page folder.

Your screen should be
similar to Figure 15

Figure 15

The Web page you created is displayed in the browser window. Sometimes
the browser may display a page slightly differently from the way it appears
in Web Page view. In this case, the bulleted list overlaps the picture and
the last paragraph wraps to the side of the picture. To stop this from
happening, you will insert a special text wrapping break that is used in
Web pages to separate text around objects.

Web page previewed
in browser window
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Previewing the Page WDWT1.15

Word 2007

2 • Switch to the New
Tour Presentation
document in the Word
2007 application
window.

• Select the bulleted list
of tours and drag the
left indent marker to
the 3.25-inch position
on the ruler.

• Move to the beginning
of the last paragraph,
before the word
Attend.

• Click in the
Page Setup group of
the Page Layout tab.

• Choose Text Wrapping.

• Save the document.

• Turn on the display of
formatting marks.

Your screen should be
similar to Figure 16

Figure 16

Although the bulleted list does not display as you want it in the Word
document, the list wll indent appropriately when viewed in the browser. The
text wrapping break that was inserted before the paragraph stopped the text
following the break from wrapping around the object. The text wrapping
break character is not visible unless you display formatting marks.

Text wrapping
break inserted
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Word 2007

3 • Switch to the browser
window and click the
Refresh button to see
the revised version of
the Web page.

Your screen should be
similar to Figure 17

In Internet Explorer the
Refresh button is .

Additional Information

Figure 17

Inserting the text wrapping break stopped the text in the last paragraph
from wrapping around the object. Next, you will use the hyperlink to open
the Presentation Locations Web page in the browser.

Refresh

Text does not wrap
around object

Bulleted list 
displayed correctly
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Making a Web Page Public WDWT1.17

Word 2007

4 • Click on the hyperlink.

• If necessary, open the
tour Presentation
Locations tab.

Your screen should be
similar to Figure 18

Figure 18Linked page opened in Browser

This page looks fine and does not need any additional formatting.

5 • Click in the title bar to exit the browser program.

• Close both documents and exit Word 2007.

• Making a Web Page Public
Now that you have created Web pages, you need to make them available
on the Internet for others to see them. The steps that you take to make
your pages public depend on how you want to share them. There are two
main avenues: on your local network or intranet for limited access by
people within an organization or on the Internet for access by anyone
using the WWW. To make pages available to other people on your
network, save your Web pages and related files, such as pictures, to a
network location. To make your Web pages available on the WWW, you
need to install Web server software on your computer or to locate an
Internet service provider that allocates space for Web pages.
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L a b  R e v i e w

W O R K I N G  T O G E T H E R  1
Word 2007 and Your Web Browser

author WDWT1.2

browser WDWT1.3

HTML (HyperText Markup
Language) WDWT1.2

tag WDWT1.6

Web page WDWT1.2

key terms

MCAS skills
The Microsoft Certified Applications Specialist (MCAS) certification program is designed to measure your profi-
ciency in performing basic tasks using the Office 2007 applications. Getting certified demonstrates that you
have the skills and provides a valuable industry credential for employment. See Reference 2 MCAS Certification
Guide for a complete list of the skills that were covered in this lab.

WDWT1.18 Working Together 1: Word 2007 and Your Web Browser www.mhhe.com/oleary
Word 2007

command summary

Command Shortcut Action

Office Button

Save/Save as Type/Web Page Saves file as a Web page document

Insert tab
Links group

c + K Inserts hyperlink

Page Layout tab
Page Setup group

/Text Wrapping Stops text from wrapping around objects in a Web page

Page Background group

Adds selected color to page background

/Fill Effects Adds selected color effect to page background
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step-by-step

Adding a New Web Page ★
1. You want to continue working on the Web pages about the new tour presentations for the

Adventure Travel Web site. Your next step is to create links from each location on the Presentation
Locations Web page to information about each location’s presentation date and times. Your
completed Web page for the Los Angeles area should be similar to the one shown here.

a. In Word, open the
Web page file Tour
Locations you
created in this lab.

b. Open the document
wdwt_LosAngeles.
Save the document
as a Web page to
the ATT Web Page
folder with the 
file name LosAngeles
and a page title 
of Los Angeles
Presentation
Information.

c. Change the page
color to a gradient
fill effect of your
choice. Change the
first title line to the
Title style and the
second title line to
a Heading 1 style. Change the title lines to a color of your choice.

d. Increase the font size of the table to 12 points. Add color to the table headings. Enhance the Web
page with any features you feel are appropriate.

e. Two lines below the table, add the text Contact [your name] at (909) 555-1212 for more information.
Apply the Emphasis style to this line and increase the font size to 14 points.

f. On the Tour Locations page, create a link from the Los Angeles text to the Los Angeles page. Test
the link.

g. Resave both Web pages and preview them in your browser. Print the Los Angeles Web page.

h. Exit the browser and Word.

L a b  E x e r c i s e s

Easy

Moderate

Difficult

rating system

★★★

★★

★

CO
NTINUING

E XER C IS ES

Lab Exercises WDWT1.19

Word 2007
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L a b  E x e r c i s e s

Converting a Flyer to a Web Page ★★

2. The Westbrook Parks and Recreation Department has asked you to modify the Celebrate Bikes
article you created and convert it into a Web page to add to the Web site. Your completed Web
page should be similar to the one shown here.

a. Open the file Bike
Event you created in
Step-by-Step
Exercise 2 in Lab 1.

b. Convert the article
to a Web page and
save it as Celebrate
Bicycling in a new
folder. Include an
appropriate page
title.

c. Apply a page
background color
effect of your
choice.

d. Change the text
wrapping style of
the graphic to
square. Move the
graphic to the left
of the title. Left-
align the title and
increase the size of the title to 36 points. Size and position the graphic appropriately.

e. Delete your name and the date from the document. Add [Your name] at before the phone number
in the last line.

f. Save the Web page. Preview the page in your browser. Adjust the layout as needed. Close your
browser. Resave the Web page.

g. Print the Web page.

WDWT1.20 Working Together 1: Word 2007 and Your Web Browser www.mhhe.com/oleary
Word 2007

CO
NTINUING

E XER C IS ES
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Advertising on the Web ★★★

3. You would like to advertise the grand re-opening of the Internet Café on the Web. You plan to use
the information in the advertisement flyer you created as the basis for the Web pages. Your
completed Web pages should be similar to those shown here.

CO
NTINUING

E XER C IS ES

Lab Exercises WDWT1.21

Word 2007
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L a b  E x e r c i s e s

a. Open the file Grand Re-Opening you created in Step-by-Step Exercise 3 in Lab 1. Convert the
document to a Web page, add a title of Grand Re-Opening Announcement, and save it as Café Flyer in a
new folder.

b. Delete the graphic. Insert the image wdwt_Coffee. Change the picture text wrapping style to
square. Move the picture to the left of the three title lines, as shown above, and size it
appropriately. Left-align the three title lines.

c. Save the changes.

d. Open the file wdwt_Café Locations. Save the document as a Web page to your Web Page folder with
the file name Café Locations and a page title of Your Neighborhood.

e. Create a link from the text Your Newly Remodeled Neighborhood Coffee Shop in the Café Flyer page to
the Locations page. Test the link.

f. Enhance the pages with any features you feel are appropriate.

g. Resave the Web pages and preview them in your browser.

h. Print the pages.

WDWT1.22 Working Together 1: Word 2007 and Your Web Browser www.mhhe.com/oleary
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